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ASA Version 9.4.1

!

console serial

interface management0/0

nameif management

security-level 100

ip address 192.168.1.1 255.255.255.0
no shutdown

interface gigabitethernet0/0

nameif inside

security-level 100

ip address 10.1.1.2 255.255.255.0

no shutdown

interface gigabitethernet0/1

nameif outside

security-level 0

ip address 198.51.100.2 255.255.255.0
no shutdown

http server enable

http 192.168.1.0 255.255.255.0 management
crypto key generate rsa modulus 1024
username AdminUser password paSSwOrd
ssh 192.168.1.0 255.255.255.0 management
aaa authentication ssh console LOCAL
call-home

http-proxy 10.1.1.1 port 443

license smart

feature tier standard

throughput level 2G

T

ASA Version 9.8.1

!

console serial

interface management 0/0
management-only

nameif management

security-level 0

ip address 192.168.0.230 255.255.255.0
!

interface TenGigabitEthernet0/0
nameif inside

security-level 100

ip address 10.10.10.10 255.255.255.0
ipv6 address 2001:10::1/64

!

interface TenGigabitEthernet0/1
nameif outside

security-level 0

ip address 10.10.20.10 255.255.255.0
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ipv6 address 2001:20::1/64
|

route management 0.0.0.0 0.0.0.0 192.168.0.254
|

username cisco password ciscol23 privilege 15
|

aaa authentication ssh console LOCAL

ssh 0.0.0.0 0.0.0.0 management

ssh timeout 60

ssh version 2

|

http 0.0.0.0 0.0.0.0 management
!

logging enable

logging timestamp

logging buffer-size 99999
logging buffered debugging
logging trap debugging

|

dns domain-lookup management
DNS server-group DefaultDNS
name-server 64.102.6.247

|

license smart

feature tier standard
throughput level 10G

|

crypto key generate rsa modulus 2048

CRIIE) A RURHE e R A BLES AT R BV PIUE S 4 A RSO N 33 81 PC.

CAIE) ARSI ID A RN S ID A4 0 “idtoken” [HSCASCAT.
L AW 3K ASAv FE S REVE ] R4S 75 o
TRDRE SCA SOl 1SO A e 8L CD-ROME:

T

stack@user-ubuntu:-/KvmAsa$ sudo genisoimage -r -o day0.iso dayO-config idtoken
I: input-charset not specified, using utf-8 (detected in locale settings)

Total translation table size: 0

Total rockridge attributes bytes: 252

Total directory bytes: 0

Path table size (byptes): 10

Max brk space used 0

176 extents written (0 MB)

stack@user-ubuntu:-/KvmAsa$

7€ Linux b5 day0.iso {1357 SHA1 {4

i

openssl dgst -shal day0.iso
SHAI (day0.iso)= ebbee36elebla2bl09311c59e2flec9f731lecbb66 dayO.iso

FE A H sk asav-vi.mf SCEFP AR HT ORI, JF4F day0.iso SHAT (R4 A 7 A2 i 42

i

SHAI (asav-vi.ovf)= de0f1878b8f1260e379e£853db4e790c8e92f2b2
SHAI (diskO.vmdk)= 898b26891cc68fal0c94ebd91532£fc450dad18b02
SHA1 (boot.vmdk)= 6b0000ddebfc38ccc99%ac2d4dbdbfb8abfb3doc4
SHAL (day0.iso)= ebbee36elebla2bl09311c59e2flec9f731lecbb6
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TEMNZ H s SRR AN, RGN AT E R day0.iso A FIRCE. .
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vCenter, 15Z W {#H VMware vSphere J37. 2% F 5 Al Day 0 it &K% ASAv, S OVF L HA
Day 0 & K5 ASAv.

* Vjla] vSphere Web 7 /™ b Jf 22 3 ) A Jl i 1F 5 55 9 0
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i7718) vSphere Web & P &2 % Fim & BUiE
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HIB1 M Y28 535 VMware vSphere Web %5/ i «
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BRNTHOLR 3 14 9443,
PE2 (0 %) i RdifE, LMED ) ASAv 6l 6
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vsername: [ VMware vSphere Web Client
passwors: - |

AT 280

2. RPHMINEAS, SRJG A e fe Iy et i
3. AT, FOBER S vSphere Web %5 F il o

$IB3 WA 4GS, AR5l Login, ik Use Windows session authentication & i%EHE (VIR Windows) .

{$ F§ VMware vSphere Web % F i & Z ASAv

BLERE ASAv, 11 H] VMware vSphere Web %5 J i (B¢ vSphere %5 7 %) ARG X (OVF)
IR SCAF . 7E vSphere Web %/ iiii i | Deploy OVF Template 1] 5 K525 ASAv i ERHR A4 .
%I FRHAENT ASAV OVF S, BIEERHIZAT ASAv IRRERINL, IR0

RZHn) T A B VMware IIbRAED IR . A CHE OVF BRI 25, 152 VMware vSphere
Web 7 7 S ERHLAS B o

FHIa Z Al

TEHRE ASAv Z i, TSUAZIFE vSphere L E /b ML (T HD .

SIE1 M Cisco.com F# ASAv 45 304, ¥ HARAER PC:

http://www.cisco.com/go/asa-software
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TR % Cisco.com &35 SAUERRS & FH o

7E vSphere Web % )7 3ii [ Navigator %%, #.il;i vCenter.
H.it; Hosts and Clusters.

{5 F VMware vSphere Web % i &1 & ASAv .

A B ASAY M dE L BEEECENL, AR5 %P Deploy OVF Template.
Z5:% 57~ Deploy OVF Template 1] 5.

I 1) 3 B ) R A
1E Setup networks Hf 7=, K 99 254 S 21 B4 FH R4S ASAv #2116

W2 ] RESEA F R HEF o W0 AR AR B M4, T LARIJGAE “YndBise i ” WHGHE 4 . 7%
Ja . Ak ASAv SEf, AR JEIEFE Edit Settings ULy ] Edit Settings X[ iGHE. {Hi2, ZhEHAS WoR ASAv 2
T ID (fU27RMEERCHS ID) o 3G S PR I 251G L4 1D A1 ASAv 4211 ID 12 5] -

M L&IEEC 2R ID ASAv 01D
Network Adapter 1 Management 0/0
Network Adapter 2 GigabitEthernet 0/0
Network Adapter 3 GigabitEthernet 0/1
Network Adapter 4 GigabitEthernet 0/2
Network Adapter 5 GigabitEthernet 0/3
Network Adapter 6 GigabitEthernet 0/4
Network Adapter 7 GigabitEthernet 0/5
Network Adapter 8 GigabitEthernet 0/6
Network Adapter 9 GigabitEthernet 0/7
Network Adapter 10 GigabitEthernet 0/8

ATEATHITA ASAv #:11; {HJZ, vSphere Web 7 Ui 23K A BT A $52 LVER /3 L 4 o T REANFT S804 FH ) 42
H, HFGTE ASAv BUE AR RIW . 7633 ASAv 5, #n] LR [HI 2] vSphere Web % /' 3iii, A Edit Settings %1%
HEFP I BR A8 . A RTEAIME B, 1214 vSphere Web 2/ 3 LS ) o

AR ST EERD)R/HA 5, GigabitEthernet 0/8 T THC & b i D) 4tz 1.

Ln S W 2848 FH HTTP ACHER 5 1a) BLIBE, U425 #F Smart Call Home Settings [X 3k 4 it & 2 GEVF vl (AR F Hu btk
HAREE— i H T Smart Call Home.

XTI DI HA 3, AR ¢ B SRR DR AT R O
* TR E B IP Mtk

IS E R I, DASUEAH [ 2% b Fi o — A TP MR — /N 46 TP Hbhik o 4 32 v 48 EAT B D) 48 )
Bl D et A BRI 1P HIhEAN MAC Ml JFTFIRMLRGR . BAL T4 RS R B & i 26 1 1P
HuhEFT MAC Hiuhk. BT &S A2 K I MAC 55 TP MO (148 4k, 4% T AT AT B AR AN 2 K 4 ARP

% HAR AL B I
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* 7& HA Connection Settings [X 35 = [ ! i S D) # 5 1% 14 i o

RIS R PR B ek 2 ANBT I I SR R R DA TR, DU B 5 B K2 1IRES . GigabitEthernet
0/8 CLTHIAC BN ik R ) Mt o A N[ — 2% LR BE RS OV S AN 45 TP Mishik.

HIB9  SERZIN T JE, vSphere Web %% ik Ab#E VM; £ 1] LLYE Global Information [X 1% Recent Tasks 4% H 7 F
“HUHtk OVF &7 R .

;}
= [z] RecentTasks |

I All | Running Failed j

Initialize OVF deployment ’

B DETesting

2

9

seln, #8427 % Deploy OVF Template 5 8R4

* [¢] RecentTasks E{

| Al | Running Failed

+ Deploy OVF template ‘
th -asavl

+ |nitialize OVF deployment

@@ DE-Testing

My Tasks - Mare Tasks ﬁ
gl i, P J =
o

B B AE 35 B AR (R 2 B R0y N 2 R ASAY VM SEF]
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vmware* vSphere Web Client # &

«.‘\_-I:i-él-r-‘re |- K | (s S asavd | Adlions =

@, Search: Getting Started | Summary Monitor Manage
(51 virtuzl Machines

. | What is a Virtual Machine?
Virtual Machines | : s

o | Avirtual machine is a software computer that.
i asav2 like a physical computer, funs an operating
e system and applications. An operating
CH asavl system installed on a virual machine is

| |

Because everyvirtual maching is an isolated
computing environment. you can use virtual
machines as deskiop or workstation
amdronments, as tasting environments, or 1
consolidate senver applications.

InwCenter Server, virlual machinas run on

hasts or clusters, The same host can run
many virual machines

Basic Tasks

W Power Off the virtual machine
10 Suspend the virtual machine
{§ Edit virtual machine settings

At s e A B i st bt i

a2

SIE10 414 ASAv VM ¥ Ki21T, 15 H. i Power On the virtual machine.

47 ASAv R, RJAZX Y ASDM BRI G IER . 2 ASAv HIXABINT, R EBGEE OVF AR IS4,
FREEANTRINE] ASAV RERCE T . ARG ASIER I SR, HRIEFET. DA HIKEE ASAVI, A=t
PONE A Bt R HAFAZHE, i Hdi Console IEI- KK Vi ASAv #2165 .

FEN T BRI HA T3, ER R A& e 2 LT R
© BOES LR R A AR .

o EINS FE B A STEAMEIR P MR E . BT H TR G &R B AR E R &S, ST
bootstrap it & AH A

T—F 4

N T ) SR AT LR ASAY, ASAv i ZEH KM T I . 55 2 Jn, Al RERT Zh AT He Al e
B, LRSI ) A S D R AT E .
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. { F| VMware vSphere Jt37 % P i 1 Day 0 B &>k EBE ASAv

{5 F§ VMware vSphere Ji 37 % 7 it #1 Day 0 it & SR8 ASAv

B ASAv, ] VMware vSphere % )7 i FT I ME RS 2L (OVF) BERRSCHE (asav-vi.ovf 1
FF- vCenter %, asav-esxi.ovf i& HT-3F vCenter {5 ) . 7F vSphere % /" Uity il | Deploy OVF
Template [7] 7R HE ASAv (I FHRIAL . 2 W ST ASAv OVF SCfF, BIHHHEAT ASAv 1
ML, IR,

KZHm T BE VMware AR HEL R . 4795 Deploy OVF Template [1] 2 [ 245 5, 152 VMware
vSphere & F i EEALAE B o
FrIGZ 7l

o JEE ASAV 2Ry, MSIAZAE vSphere L E /b — AL (T .

o JEIR R 40 ASAV AT IO Day 0 FiL'E SCHF . 55 6 T P ERAIEHE Day 0 fiL'E

B 1 33 VMware vSphere & /7 Ui, SR 5L F: File > Deploy OVF Template.
BB I Deploy OVF Template 7] 5.

PR 2 WK asav-vi.ovl SCHHR RSN TAEH S, RGPt .

PR3 MR SR OVF BIRTELNE Ko R8T LU & DiAE . WUREEE SR B € X Day 0 B E S, WAL B AT
(LGN

R4 B AR BOR B WA 2L . i Finish F025 LA

SIES 53 ASAv, FJF VMware #56, RIGZERE _IREE.

FIR6 i SSH IEHF| ASAvV JEE T T HINL'E . 4R Day 0 BCE XA AN BRAKHER I ARCE, WHTJT VMware 2
B IF 5 R E R

ASAv IUAESE 4 IEHIEAT

{5/ OVF T E %1 Day 0 Fi. E 5k &3Z ASAv

AN H T OVF TH#% ASAv, #7542 Day 0 i & 1.

FHiaZ |l

* i H OVF T35 ASAv I 72 day0.iso SCfF. £ AT LA BRIA 1 day0.iso SCAF CHR4E S
AL, AT DA S A I H 2 X Day 0 Bt B SCPE. EHAIE Day 0 Fl & S0, SR
% ASAv BAEIFGIE Day 0 B & SCHE, 556 1.

 #iff OVF T H 235 4E Linux 8 Windows PC &, 3F H O824 00 H AR ESXi RS 2.
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e asavizsia [

AF 2R %3 OVF T H
w15l

linuxprompt# which ovftool

A R P (R A2 T A — A .omd SO
T

linuxprompt# cat launch.cmd

ovftool \

--name="asav-941-demo" \

--powerOn \

--deploymentOption=ASAv30 \

--diskMode=thin \

--datastore=datastorel \

--acceptAllEulas \
--net:Management0-0="Portgroup Mgmt" \
--net:GigabitEthernet0-1="Portgroup Inside" \
--net:GigabitEthernet0-0="Portgroup Outside" \
--prop:HARole=Standalone \

asav-esxi.ovf \

vi://root@10.1.2.3/

AT1% emd A
w1l

linuxprompt# ./launch.cmd

ASAv JA3l; HRFE S,

L SSHIERH ASAv SE B f AL E . WERT Z B RCE, THITIT VMware #2115, BEA ASAv, JFN N2
fRIHC .

ASAv IAE 584 IEHIEAT

18] ASAv =& &

X T ASDM,  AEREEEAEDL T W] RE 5 24 A CLIEAT #ieba bR . BRIATEOUS, 0T LAVG ) A & VMware
vSphere il &, W n] IBCE M2 T30 &, E AT RIIRE, R HARING.

* fi /| VMware vSphere 1| 5
o PO R 2% ER AT AR A 65 i 1
)
AR WIRAEN Day 0 i E SCAHRE ASAv, AT LIZEIZAC E SCAF L4 console serial BEE, LMEAEE 1R)H3)

T AR R R AT AN 2 B R VGA #5614 IS AR R 45 ASAy A4 017 Day 0 fic & S04
56 U,
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. {&F VMware vSphere 1= &

& F§ VMware vSphere i1Z#| &
KT WA & s HERR, MBI VMware vSphere Web % /7 s $2 {1 KE S8 1) 5 U7 in) CLI. f70] L
)5 M Telnet 5%, SSH fic & CLI ZAE V5 ] o
FFeaZ Bl
X} vSphere Web & F' iy, %625 P um AR G, I AL VT ] ASAv 5 5 BT T

1 VMware vSphere Web % P i, AL ohiig S (1) ASAv 524), SR J51%+E Open Console. 557, fn] Ll
Summary %5~ ] Launch Console.

PB2 kil G, A5 Enter B, 7R 4% Ctrl + Alt Al BEEOGHR
R ASAV BEJA BN, o BRI

4 ASAv RSN, R BUEE OVF SRS L IR ETising] ASAv RERCE T . Rt A E A5
TR, HEFNERIEZIT. DCHE RS ASAV I, A B R 3hid 2.

R LELREVFOIUEZ A, AR A 100 kbps, MBS AT LAHATHI D BRI . 75 2 2238 VP Al e A fE IR
BAT. LA IEZH, BESERLU N EBAEEREG LEEHI:

Warning: ASAv platform license state is Unlicensed.
Install ASAv platform license for full functionality.

R 2 LU 3R

ciscoasa>
I SR PR EIEAL T P EXEC 245 . H P EXEC S5 Re sk IUEA A £ .
FE3 YA EXEC 15

-

ciscoasa> enable

ARG R Ll N s

Password:

WIE 4 1% Enter H4A2:. BOMEOLT, #9420 WER LIRSS 8 2, 3% A %S0T AN 2% Enter 8.
PR -
ciscoasa#

TERF EXEC M5, FradERLE ar 23 . 18] WEFAL EXEC -5 3N il & 5.
FUERHAFRUN S, S disable. exit B quit 174

PERS Vil 2R E R

ciscoasa# configure terminal

s O B A

ciscoasa (config) #

. & F VMware #BZ ASAv
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ramasrrsant [l

0] DU JRC B A5 R AR . ASAv. ZLEH A RRCE IS, 1M exit. quit 2 end 7% o

fic & W 48 SR T & im0

AT A AP 5 AR, AT LRI X 245 5 AT i 11 BI04 B g UL AR A T 3 1 A 4% (VSPC) HEAT
WG ViR . A RBRVENTENE R, 7520 VMware vSphere SCR . 7E ASAv I, AUk &
i R AR B A AT I AN PR 6 o SRR ST S T R AT i P 6

HIE1 7 VMware vSphere HHCE M4 4T . 152 % VMware vSphere A% .

S 2 £ ASAv ¥ disk0 AR H 3k N EIEE— 44 “use ttyS0” HISCHF. AT ERTMAE; ERGEEM IS
1FAE:

disk0:/use_ttySO
* 7£ ASDM 1, HJLLffi ] Tools > File Management X 15 HE [ %1% 4 FR 1125 SCACF .
* & vSphere ¥l G, 0T LUK SO RS A X (BRSO B 408, il

ciscoasa(config)# cd coredumpinfo
ciscoasa(config) # copy coredump.cfg disk0:/use_ttySO

T3 PN ASAv.
* 7£ ASDM K %+ Tools > System Reload.
* {E vSphere il 54, A reload.
ASAv 15 11 R 1% 3 vSphere ¥l &, T2 KIE S BHATIEGIG

SR 4 Telnet FIEAEASINEB AT 5 H 45 52 ) vSphere AL IP Ml Al 05, Y Telnet 3] vSPC IP Huhik Al .

7t2% vCPU St F ML S 1FAIE

ASAv FH B AHE, EaimiEa] LR vCPU e .

R (b)) ASAv ) vCPU %o, %8 a] DLHIEBriFal e, NHDHFAE, JH/E VMware
AR 5 VML g 1t LA DS e B4

AR I vCPU BRI ASAv REHL CPU ¥ ufiE sl it BV vl IEAH AT . RAM a5 45044 vCPU %
BT IER . THRR BRI, 15 5% 4% IR i B A O 37 BV B8 F i UE AT vCPU . B R A FR 4t
ANULHL, ASAv JCVEIEH TAE.
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B sroviznnE

PIES
$IE6
P17
$IE8
$IE9

S0

R B VF AT IE o
I FT VR A IE . 6 TR ons, A TV I N T B PN B
PATEL R A2, BAREGR T2 A5 A A s e .

o fi FH BT V)3 - 7€ vSphere Web % i, JCHI4 H ASAv. #lll, i ASAv, 4RJ5 ¥ Power Off the
virtual machine , U A HE AL ASAv, R)51EFE Shut Down Guest OS.

o ANd ML) 45 - 76 vSphere Web %% i, S ASAv. B, i ASAv, #XJ5 #iili Power Off the virtual
machine, B{E AT ASAv, #RJ51EF Shut Down Guest OS.

it ASAv, #RJ5 i Edit Virtual machine settings (E0E 178545 ASAv, 2R J5iEFE Edit Settings) .
Z 505 o Edit Settings X G AE .
THZ I ASAv [VF R ) CPU/ N AT R LARE B vCPU VRl lk (1 IEAf{E -
fE Virtual Hardware JEIUK I, W FH 8R4 CPU EFHiH.
X7 Memory, fiiA\ RAM [H1{E.
il OK.
JA 3 ASAv. 4, .t Power On the Virtual Machine.
X R AR -
L AT s il & 88 2 EH B L) ASDM.
2. KMWATEREBNG, Wby R) % 3%
* ASDM: 1K {X#tF$ Monitoring > Properties > Failover > Status, X5 il Make Standby.

* CLI: failover active

3. WIS B EE K3 9.

T—F Mt 4
ARHEAE R, WS IASAv [MTVFT .

SR-10V 3% & Fc

SR-IOV A VM NN — PCle M4 ERL#S. SR-IOV & X T FAIDfE:

« WP L)HE (PF) - PF 5014 PCle ThAE, 045 SR-IOV TRk, IXLLThaedE THUIRS: 2% b Wom b w 3
# A NIC,

* REFLDIRE (VF) - VF 247 B T 2L it 42 4L PCle Tyfg. VF VS A T PF, JRifiid PF #4748 9.
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| 1M vMware E38 ASAv
AT |

VF 1E M A RGHEZE N, deii il LL 10 Gbps 138 5% ASAv RERIPL. A4 anfi £ KVM
IR LS VF. ASAv fll SR-IOV LA T ASAv X SR-IOV 2 -5 B .

JHE ) 01 PR )

SR-10V £ /N
VMware vSphere 5.1 M 5T i SRAA A BAT R 8 BC B A58 T S 8F SR-IOV. i H SR-IOV I, vSphere
(R LE T e Jok e LA

K 7 SR-IOV 22 LI HE R PRI P TR () ASAv Fil SR-IOV [ R G HEk 2 Ak, BB N 1% VMware 3
R SR SR-IOV UECE, DL T AT e Bisk . S8 NIC. ThEn] FIME &% VMware #1 SR-IOV
Fh 2 SR T T VRGNS B .

AATAHLE VMware 240 LIRS SR-IOV 2 L 15 F0 3 B FIRCE DR . AT Hh (5 BIE TR e sk
FEINEE B E A, IX ST Y VMware ESXi 6.0 FI1 vSphere Web %% )7 it SR UCS C &
Bk g4 M Intel LK I 55 2 IE FL 45 X520 - DA2.

SR-10V #£ O &Y PR

JA 5 ASAv I, TEVER SR-IOV £ 1 BLN T r] B 5 BESXi A 2 n P A s . IX AT RE S R 3 R
BEAR, SEERER ASAV IG5 iE 8z

IR JFURAE ASAv L SR-IOV W83 2 fi, HoBb b W 950 F 8, 3 ] Af ok 9 285 2% 1 G &
NHE VM ENLEIE# Y3 MAC Hihkdz .

ASAv JA )5, #En] LUFIAMES MAC Huhb w205 #2100 . 548 H] show interface iy 2 £ & 1£411
EOGE, OO MAC Hulk. ¥ MAC Hulik 5 show kernel ifconfig fiv 4 1Y 45 S HEAT LL I LAFA
MR E AN T

¥ & ESXi £ 41 BIOS

BHE VMware #8375 SR-IOV #2011 ASAv, LR AL . VMware $E4E T JUFRE6IE A2
LRI 77, ARTHAEL SR-TOV SR 2 PEFR LA S T R 3R CPU 3 S R ORI i
AL T B SRR

JiAh, BIE T LUE R R B ESXi EAHUKAA E 2 15 7E BIOS A I T AL .

$B1 ] N7k — %53 ESXi Shell:
o WTRETTDLE BT ) EHL, E IR A2 FT IR AL B ) S S S TR
o WURGIEAEE R RE ML, E T SSH ml Hofh e 45 bl & R L LR B4

T2 AP 2 A .
PR3 BT i
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B =xmmamns e/ shiov

Al
esxcfg-info|grep "\----\HV Support"

HYV Support 774 (1 H H 7 7] B I BN LSRR PR . A7 6 mT e AR 1 W A T
0 - VI/AMD-V KR iR T A AT ]

1 - VI/AMD-V £/r VT 8 AMD-V o[ Ger] A, (HUbEEAASCREEA .

2 - VT/AMD-V %R VT 8¢ AMD-V 1], {HH#i#E BIOS KK .

3 - VT/AMD-V %75 VT 8 AMD-V 7£ BIOS H i I, JEH LM .

T

~ # esxcfg-info|grep "\----\HV Support"
|====HV SUPPOTL ... ittt ittt it 3

B 3 s>y He m AL .

T—5Hit4
o EEHHIE RS A ] SR-IOV ..

FEEHHIRIER EE L /5 F SR-IOV
{577 vSphere Web % /i I SR-IOV, JF B WL 1 MO REALIN AR AR, (ESRATILIRAE 23, 0%
F4 AL L B A DD .
Fh 2

o TEMR O LA SRIOV [ 2548 11K (NIC); 152 [SR-IOV SZ£5 (1) NIC.

B 1 1 vSphere Web % i, FHIEIZ ) SR-IOV 1) ESXi 4L,
I 2 /& Manage £~ |, Hif; Networking JfiE+¥ Physical adapters.

Ll SR-IOV g1, DA T R BLGE OS2 75 5 FF SR-IOV.
WK 3 IEFYHIENE, S5 Hili Edit adapter settings.

$ 4 £ SR-IOV F, M Status FH2ZH %+ Enabled.
#IE 5 7t Number of virtual functions SCAHMEH, Bl N BN 120E f 25 E B 1 AT REE H -

ER AT ASAVS0, FRATEUEO RN ) VE SR AR 1A RS 2 A ) e L A
H, AT Reas R BLIERE R R

L6 i OK.
$IB 7 T ESXi THl.
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| 1M vMware E38 ASAv
Bl 3Z vSphere 334/ .

REAULI RELE ) B E A3 T 7 1 NIC g 1 R A s R A o EATT R 757 ML Settings LEI5-K 1) PCI Devices 41
S L

T—5Mit4
o G EE—ANbrvE vSwitch KA FE SR-IOV ThHERITL & .

1] vSphere X3l

B —™ vSphere AT #eH K& # SR-IOV # M.

PR 1 {r vSphere Web % P, ‘FMHia ESXi F4l.
IR 2 7F Manage I, %#% Networking, #RJ51E+¥ Virtual switches.
S 1% 3 i Add host networking E¥r, BI7H NS (+) MR EERD E
18 4 % Virtual Machine Port Group for a Standard Switch #2257, SR )5 #.il; Next.
WIRS ILEFE FEAREZ ML, )5 R Next.
IR 6 K B0 2% 3 ARV I 2B (R B HEAZ 4L
a) TEATLHNERCAS T, Fligk e’y () URIn&EEsE .
b) MFIFF N SR-IOV EFEAN 4% 1. B0 Intel(R) 82599 J5 IKAL XUt 11 194 4% 3% 4% o
c) M Failover order group FH =i, L Active adapters.
d) i OKo
PIRT 1% SR-IOV vSwitch iy A — A FLEHREE, SR)5 Hiifi Next.
I8 8 1 Ready to complete UL F &AL, SR)5 51 Finisho
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1: 2% SR-I0ViEORIF vSwitch
Geting Started  Summary  Mondlor | Manage | Relaled Objects
Semngs | Networking | Siorage | Aarm Defntions | Tags | Permissions

a Virted| swilchs

| vitalswiches [N PPN

Vilerme adaplers

-. . e
Piwsical adaplers £ vawstcho
TCPAP configur ation £ vowilthi
Aibranced
Standand wiich: vSwalch1 [(no e ek ced)
|2 1556-5RION i)
WLAM 10K =

* Virtual Machines (1)

T—¥#ita
© AR AL HR 0N .

TR E P B RS Rl

1% VMware 232 ASAv |

¥ Physical Adapters [
= @ vmnicO 10000 Full i ]l

HEA G Yo vl T AU LR REAURELE, BN 15 L L mT T B AR X N . ASAv KESUAIL A
PRGN T EE R 10 R 0N . XAEA TR SR-IOV B D) AES #2457 ASAv. LU N ERAEFERS W] 37

BIKE ASAv T2 S fe Bt SR (1 RS A RRCAS o

A RN UL AR AR NE N5 S 75214 vSphere REUBLE BEICRY .

S8 1 J\ vSphere Web %% /7 uifi B 5k 2] vCenter IR 55 %%
T2 HEEEU ASAV EHHL.

a) EPEEHE O e, BEE. WP, AR5 Hiili Related Objects 21~ .

b) 7 Virtual Machines, JfMZIZRFESE ASAv HEFUNL.

PR3 KPPTIEREIHL

SR A4 A% ASAY, FFHKIKIEFE Actions > All vCenter Actions > Compatibility > Upgrade VM Compatibility .
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1 sr-tov Nic 5524 Asav ||

LIS Hid5 Yes LUFIIA T2
PR N EAUNLACAVEEFE ESXi 5.5 and later 17
ST (A]ik) %FF Only upgrade after normal guest OS shutdown .

JITIZE R AN LA T 25 O S e 3% AOAR A AR A TR SHE AR PR B, O ELREAUUML R 4 LA 300 moks SEO0T D0 B (K0 A AR

T—5Mt4
o I SR-IOV Hil M4 E I 254 1% ASAv 5 LN RE L,

1% SR-10V NIC 5 Bc 25 ASAv

J3 TR ASAv EFUNUFIAEE NIC W RIAS e, 1802006 ASAv 5 —ANakZ AN HI1E SR-I0V Fil
DR 8% 3T FC g4 1D REPL S AR e . DA AR e U B el £ vSphere Web %5 F 3 SR-IOV NIC 43
fii4s ASAv ERIHL.

1B 1 M vSphere Web % J' i 5 5% 3] vCenter 5545 o

PR 2 HBEE ) ASAV EHUHL.
a) EPFEHHE O e, BEE. PRV ENL, SR)5 HiF Related Objects LT .
b) Hili Virtual Machines, JM\FIF& P IEF: ASAv EHIAL.

IR 3 BN Manage IR |, MKIKEFE Settings > VM Hardware.

LS4 Bk Edit, 2R)51EFF Virtual Hardware 250K,

$IR5 M New device FHEH 1, i%+F Network, SAJ5 .7 Add.

#4954 7~ New Network FLfl
SIE 6 EIT New Network #547, JFEFEn ) SRIOV £ .
$IB T M Adapter Type [ 11k $ SR-IOV passthrough.
1% 8 I Physical function [/ 2 HH, E£E5S 5 IH R SN LG A 83 ARG (14 BELIE B 4% o
LR Pl BN .

BOHREAUNUHEE, ESXi EAURE WIS B a5 g+ DR R Lh g, IFR LU 2] SR-IOV
FLEIERC s . EHURSI0AE E FUAT LA C 25 A2 B2 U 2h RE (M T s 1

= - e WH- &b
125 ESXi Bt B BY % RE
TELL I ESXi EHLA CPU FL'E s, W LA = ESXi MR35 i ASAv VERE. I8 ol ifff B Sk I,

A DL REAUBL CPU {E LA B Z L (FEEAE, R R A YR WA 5. Rt
TR, EnT LR R HE AL 23 O 298 A ST EH H (R AR BE 5%
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B == esximmmna

HREMFE, ESHLLT VMware 3CRY.
* (vSphere T LY I CPU B —5,
* {VMware vSphere [V RERAESZER) -

* vSphere &/ Ui HEHLTE B o
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